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Pilot Operations Handbook

VERSION 3.0 - March 15th, 2026

Solaris Air is a fictional Virtual Airline and is not intended to be affiliated with  any real world airline. 
Any information found within this document is for Flight  Simulation use only.

This is the operations handbook for Solaris Air VA pilots. Inside this document  you will find 
information regarding our day to day operations and what is  expected of our pilots.

The VA's website is listed below in red. The website has company news, flight operations, 
downloadable liveries for our fleet of aircraft and more! All pilot's are  required to use this website! 
Bookmark it!

This document is subject to change at any time without notice. This document is NOT to be used for 
real world aviation or navigation.

Our handbook does not supercede, or exempt any member from any other EULA, CoC, or Regulatory 
guidance for any necessary software that will/can be used (i.e. vaBase / client software / forums, the 
VATSIM Network, xPilot / vPilot, etc.) nor any local / regional / international Laws.

WWW.SOLARISVA.ORG
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Welcome to Solaris Air!

We are delighted that you have chosen to join our 
Virtual Airline (VA). Whether you are new to flight 
simulation or have been in the hobby for decades, we 
welcome pilots of all skill levels. Our airline offers a 
little something for everyone.

Solaris Air is organized into multiple divisions that 
support different aircraft types and styles of flying. 
We will explain more about these divisions later in 
this document. For now, we simply want to 
emphasize what Solaris Air is all about: Fun and 
Flying!

That said, before we move on to the next section, 
there are a few rules and expectations that all pilots 
must follow. While we do not believe our policies are 
overly strict, we do maintain quality standards to 
ensure an enjoyable and professional environment 
for everyone. Additional hiring requirements for the 
VA are listed later in this document.

1. Flight Activity Expectations

All new pilots must complete their first flight within fourteen (14) days of being hired.

After your first flight, we expect pilots to complete at least two flights every thirty (30) days to remain 
active. One of those flights must be from the Scheduled airline routes. If you anticipate being unable 
to meet this requirement, you may request a Leave of Absence (LOA). Pilots on an approved LOA will 
be exempt from the 30-day activity requirement for up to 90 days. If you have to be away longer than 
90 days it is best to leave the VA and rejoin when you can find the time commitment necessary to be 
active with us.

2. Airframe Knowledge

Pilots are expected to have a working knowledge of the aircraft they intend to fly.

Please ensure you understand how to properly operate the aircraft before booking a flight. Practicing 
offline is encouraged until you are comfortable with the aircraft's systems and procedures. Repeated 
poor landings or aircraft damage during active flights may negatively impact your service record and 
results in suspension from further flight operations.

Training assistance can be provided upon request in the Discord #request channel.

3. Respect Your Fellow Pilots

Our pilots interact frequently on Discord, and we expect everyone to conduct themselves in a 
respectful and professional manner.

Disruptive behavior, excessive arguing, or intentionally provoking other members will not be tolerated. 
Healthy discussion is welcome, but please respect the opinions and perspectives of your fellow pilots.

4. Book It, Fly It

Flights should generally be booked when you are ready to fly. Refrain from booking an aircraft hours 
in advance when doing Scheduled flights. Free Flights do not matter but Schedule flights tie up the 
airframe. No one else can use the aircraft if you have it locked down for a future flight. Please do not 
book a Schedule flight more than two hours in advance.

5. Aircraft Incidents

Mistakes happen. Simulators glitch. Occasionally, gremlins eat airplanes.

However, crashes caused by pilot error or lack of familiarity with the aircraft can negatively affect your 
performance record and promotion prospects. Always ensure you are comfortable operating the 
aircraft before beginning a flight.

If an aircraft crash occurs due to pilot error or simulator issues, you are required to file an NTSB 
report on the #ntsb channel on our Discord. These reports are reviewed by staff to determine 
appropriate follow-up actions. Detected crashes and very poor landing ratings results in auto 
suspension pending investigation.

The current VA officers you can contact on Discord or through NewSky are as follows:

Brian “Captain K-Man” Navy - Owner & CEO of Solaris Air

Lance “LRPTV” Loomis - Chief Operations Officer (The Coo™)

As the airline grows new officer positions may open up depending on our needs. When such an 
opening appears we will post it in the Company News channel on Discord and place it in our NewSky 
feed.

In order to be an officer of the VA you must meet certain criteria as outlined below:

• You must be 18+ years of age.

• You must have at least the rank of Senior Captain to be considered for the position.

• You must be active on our Discord and available throughout the 
week.

Officers are responsible for seeing to new applicants, handling promotion 
requests and moderating the Discord as needed.

If you think you’d like to be part of the management team look for those job 
postings and apply!
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Our Virtual Airline is powered by the NewSky network and it’s ACARS 
tracking software. This powerful and easy to use software package is intuitive 
enough that you can be quickly grasp the website and app usage. Further 

tutorials on how to use the basics will be given later in this document.  You 
should familiarize yourself with the basics of how this platform works though on 

your own by reading through their WIKI information pages located here:

https://wiki.newsky.app/
Make sure you read and fully understand the sections under the Flight category for sure. This will 
teach you about how to book flights, the different flight rules, how your flights get rated and how to 
delete a bad flight.

I would read the section on Aircraft as well to familiarize yourself with the different aircraft NewSky 
can work with and know your aircraft weight limits.

Our old handbook had a section on how to book flights with our old FSA as 
vaBase system but we have replaced that with a training video on YouTube 
that will show the basics of how to use NewSky. You can find the link to the 
video here:

https://youtu.be/arSG07rNrFE

JUNIOR OFFICER - Welcome to the team. All new pilots come in to the VA 
as a trainee junior officer but you won’t be staying here for long if you have 
the will to fly. Are you ready to begin your career with us?

Key Requirements: 1 Flight with 1 hour. 7.0+ Pilot Rating.
O1-SECOND OFFICER - You are officially part of the flight line team sitting 
in the right seat of a commercial aircraft. You have proven you are willing to 
stay with our community and perhaps for the long haul.

Key Requirements: 20 total flights, 40+ Flight Hours, 7.5+ Pilot Rating.

Ranking up requires three criteria be met to be considered for promotion. You need a certain number 
of flights, flight hours and a good pilot rating. Each rank below shows how much of each is needed. 
NewSky doesn’t have a ranking system so we use Discord name tags to show our ranks.

It is the responsibility of the pilot to inform a Solaris VA officer when they are ready for a promotion. 
When you meet the criteria put in a promotion request in the #request channel on Discord and we 
will review your records and promote you then. Please allow a day or two for the review process.

O2-FIRST OFFICER - You’ve worked hard to get here. The coveted left 
command seat is now within your reach. Keep at it and you will be the 
captain before you know it.

Key Requirements: 45 total flights, 90+ Flight Hours, 8.0+ Pilot Rating.
O3-CAPTAIN - All your hard work and dedication to the airline have paid off. 
You are now the captain of your own commercial aircraft soaring above the 
earth. Be proud of what you have accomplished.

Key Requirements: 72 total flights, 150+ Flight Hours, 8.5+ Pilot Rating.
O4-SENIOR CAPTAIN - You’ve made it to the bottom of the elite ranks. You 
have truly shown your love of the airline and have put in the effort to help 
make us the best VA out there.

Key Requirements: 140 total flights, 290+ Flight Hours, 9.0+ Pilot Rating.
O5-EXECUTIVE CAPTAIN - You are in it for the long haul now. If you made 
it to this rank you are truly dedicated to the airline. You are truly an elite pilot 
that has earned their wings.

Key Requirements: 220 total flights, 460+ Flight Hours, 9.2+ Pilot Rating.
O6-SENIOR EXECUTIVE CAPTAIN - Welcome to the team. All new pilots 
come in to the VA as a trainee junior officer but you won’t be staying here for 
long if you have the will to fly. Are you ready to begin your career with us?

Key Requirements: 310 total flights, 650+ Flight Hours, 9.5+ Pilot Rating.
O7-CHIEF PILOT - You are king of the hill. You have spent over a year or 
more of your real life flying for us and we appreciate you being here the 
whole journey. Wear this rank with pride and honor.

Key Requirements: 430 total flights, 900+ Flight Hours, 9.7+ Pilot Rating.
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In order to maximize the overall experience for everyone involved, Solaris Air 
follows a strict Code of Conduct policy. Violations of this policy may result in 
disciplinary action against the offender, up to and including termination from 
the airline and removal from all services associated with Solaris Air, including 
the Discord server.

Solaris Air officers reserve the right to refuse participation or membership to 
any individual, for any reason, at any time.

This Code of Conduct serves as a general guide for behavior expected of 
individuals participating in any services offered by the airline. This includes, but is not limited to, the 
VA base system, forums, VATSIM, IVAO, PilotEdge, SayIntentions.AI and the Discord server. Any 
official communications regarding the airline, or situations where you are actively representing 
Solaris Air on external platforms, are also subject to this Code of Conduct.

• Platform Rules: Every member of Solaris Air must abide by the rules and regulations of any 
platform while representing the organization.

• Respect for Fellow Members: Respect is a fundamental value within organizations that foster 
learning and support a diverse community of members. Solaris Air expects all members to treat one 
another, the organization, and the flight simulation hobby with respect.

• Legal Compliance: All members are expected to follow the laws and regulations of their place of
residence, as well as the laws of any location from which they are accessing Solaris Air services.

• Responsible Communication: Solaris Air encourages the open exchange of information and 
ideas, provided that such content is legally obtained and shared responsibly. While we respect 
freedom of speech, members are expected to communicate respectfully and constructively. Abuse of 
this freedom may result in disciplinary action.

• Zero Tolerance for Discrimination: Solaris Air is home to a diverse community. Discrimination 
based on sex, race, religion, nationality, or simulator platform used (yes, it happens) will not be 
tolerated. Derogatory language, harassment, or discriminatory behavior has no place within this 
organization.

• Illegal Activity: Members may not use Solaris Air services for the advancement or facilitation of 
illegal activities. Our organization will cooperate with any law enforcement agencies conducting 
investigations involving members (current or former).

• Graphic Content: Any form of multimedia content considered graphic, explicit, or disturbing in 
nature is not permitted on any platform or service used by Solaris Air for official operations.

Solaris Air welcomes a wide range of pilots, as mentioned earlier in this document. While we have 
already touched on the major requirements for joining the airline, this section outlines a few 
additional expectations for new pilots and further emphasizes the rules previously discussed.

Anyone applying to become a pilot with Solaris Air automatically agrees to abide by all airline policies 
and regulations, as well as the Standard Operating Procedures (SOPs) outlined in this handbook.

Our basic hiring requirements are as follows:

• All new applicants must use a realistic first and last name, properly capitalized. We prefer 
that you use your real name; however, for internet privacy and security reasons, we 
understand if you choose not to.

• All members must own a legal copy of one of the following flight simulators:

Microsoft Flight Simulator 2020/2024 or Laminar Research X-Plane 11 or 12.

• All members must be at least 13 years of age and agree to abide by all laws and regulations 
governing online activity.

• All members must have access to a stable internet connection.

• All members must be willing to download and use the NewSky client and any required 
plugins.

• All members must abide by our activity policy:

Your first flight must be completed within fourteen (14) days of being hired, and at least two 
flights must be completed every thirty (30) days thereafter. One of those flight must be a 
Scheduled route. Free Flights earn 25% revenue for the airline so we encourage flying the 
schedules whenever possible.

• All members are required to install Discord and join our server community. Discord is our 
primary platform for announcements, communication, and support. Members can share flight 
screenshots, receive technical help, and connect with other flight simulation enthusiasts. 
Solaris was founded because the founders felt there was a lack of community behind the VA’s 
out there. We want people! Not just numbers on a moving map!

• All members should have a basic understanding of aviation fundamentals and be capable of 
operating the aircraft they intend to fly. We strongly recommend 
practicing offline before flying on the live network. If you need 
assistance or training, please ask for help on our Discord server where 
fellow pilots and staff can assist you.

NewSky grades EVERYTHING. You need to be able to hit the touchdown 
zone and the centerline. A pilot rating of 7.0 or higher is needed to stay 
employed with us. We’d prefer if everyone could have an average of 9.0 
or higher as your rating affects the airline’s rating. Strive for perfection 
in every flight!
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YOU MUST JOIN OUR DISCORD TO BE FULLY HIRED INTO THE AIRLINE

In order to maintain communication with our pilots, Solaris Air primarily uses 
our Discord server. The server contains several channels dedicated to 
Solaris Air operations, including Company News, General Chat, 
Screenshots, and NTSB Reports. These can all be found under the 
Solaris Air category.

You can join our Discord server by clicking the link provided below.

Due to past issues with spam and malicious accounts, phone verification 
is enabled on the Discord server. You must have a valid phone number 
registered with Discord and be in good standing with the Discord global 
community in order to join.

https://discord.gg/DqRjX4sp9M

When you first join the Discord server, there is a five minute waiting period before you will be able to 
interact with the channels. After the waiting period, navigate to the Solaris Air channel category on 
the left side of the Discord interface and locate the #va-pilot-authentication channel.

Post a check-in message in this channel using the pilot name you registered with when applying to 
the airline. You must include the phrase in your check-in;

“THE FUTURE OF FLIGHT IS NOW!”

This let’s us know you have a copy of this handbook and have read it. Once your membership has 
been verified, your rank tags will be added to your name and you will be given the proper roles and 
are all offically hired by the VA.

NEWSKY COMMUNICATIONS SYSTEMS

We quite often relay news through the Feed system on our VA page on NewSky so be sure to check 
it. The latest feed posts are usually in your home dashboard when you login to NewSky. There is 
also a built in messaging service that allows us to send real time messages to you that you can 
respond to. We can even push messages to you through the NewSky app while you are flying. Such 
messages will show up at the bottom of your sim window and you will hear a chime sound to let you 
know you have a new message pending.

SOLARISVA.ORG WEBSITE

Our company website is also a central hub for the latest information regarding Solaris Air. We 
regularly post NOTAMs covering new routes, aircraft additions to the fleet, VATSIM events, New 
Livery availability, NTSB crash investigation summaries, and other operational updates.

We encourage all pilots to bookmark the website and check it frequently to stay up to date with 
airline activities.

Solaris Air is the operating entity under which we fly. Our VA has been organized into fleets of 
aircraft. Each fleet has its own routes and purpose which are defined below. You may fly in any fleet 
you wish and switch between them as needed for your flight enjoyment. Note that our callsigns 
SOLARIS, SUNGOD and SUNFLARE are registered names on the Pilot's Edge network so you can 
use these in your flights there. However on Vatsim we only use SOLARIS as our callsign regardless 
of which division we are flying for. Vatsim only allows one callsign per VA.

SOLARIS AIR - ICAO: SOA / CALLSIGN: SOLARIS

This is our main commercial PAX division which is based in the United States and provides domestic 
services to the US, Mexico, Canada and the Caribbeans.

HUBS: KDFW, KSEA, KPHX, KLGA
AIRCRAFT FLEET TYPES: 73x, A31x, A32x,

SOLARIS EURO - ICAO: SOE / CALLSIGN: SOLARIS EURO

This is our European domestic sister company providing routes all across UK, Europe and the 
Middle East.  CURRENTLY MOTHBALLED

HUBS: EGKK, EDDF

AIRCRAFT FLEET TYPES: A31x, A32x, B73x, E175x, E19x

SOLARIS REGIONAL - ICAO: SOF / CALLSIGN: SUNFLARE

This is our US based regional fleet which provides similar routing as the main PAX division but with 
smaller regional planes.  CURRENTLY MOTHBALLED

HUBS: KDFW, KSEA, KPHX, KLGA

AIRCRAFT FLEET TYPES: CRJx, E14x, E17x, E19x

SOLARIS CARGO - ICAO: SLC / CALLSIGN: SUNGOD

This is our cargo fleet which operates domestic US cargo routes as well as world spanning 
international cargo long hauls.  CURRENTLY MOTHBALLED

HUBS: KMEM, KDFW, KSDF

AIRCRAFT FLEET TYPES: B77L, B748F, A300F
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CAN I PAUSE THE SIMULATOR?
Yes. If you need to step away from your PC, you may pause 
the flight and resume it later HOWEVER, there is a 45 
minute time limit on paused flights. After that NewSky will 
assume you have CTD’d and delete your flight.

CAN I USE TIME ACCELERATION?
No. Time acceleration is disabled because it can be used 
as an exploit to gain pilot hours for ranking up. This keeps 
all pilots, whether flying long haul or short haul, on the 
same playing field. If time acceleration is enabled, the flight 
will automatically be voided.

I CRASHED A PLANE… WHAT DO I DO NOW?
File an NTSB report on our Discord in the #NTSB channel. 
Just tell us the basics of what happened. We will pull the 
FDR of the flight and write up a colorful official report and 
restore you to active duty.

A crash automatically Suspends a pilot and until you let us know what happened in the NTSB 
channel you won’t be reactivated. This is to protect the VA’s reputation and bank accounts from trolls 
or really terrible pilots who need more training.

I WON'T BE ABLE TO FLY FOR A WHILE. WHAT DO I DO?
Submit a Leave of Absence (LOA) request in the #requests channel on our Discord. If you are going 
to be gone longer than 90 days you will have to reapply to the airline when you get back. The longest 
we can put you on leave is 90 days before you are auto kicked for inactivity.

THE PLANE I FLY DOESN'T HAVE A SOLARIS LIVERY. CAN WE HAVE ONE?
Yes, provided a livery painter is available. We operate many different aircraft types in our fleet, and it 
is our goal to eventually have at least one Solaris livery available for each aircraft type.

If you would like to request a livery, post in the #livery-central channel on Discord and let us know 
which aircraft you are looking for. We will add it to the development list.

CAN I SUBSTITUTE THIS AIRFRAME FOR THAT AIRFRAME?
No. If it’s an A320 it must be an A320. We actually buy our planes based all the way down to the 
engine type and wingtip configuration.  You MAY be able to get away with using another aircraft 
developer’s A320 or a different engine type but be sure at the end of the day, your ZFW matches in 
your FMC vs. your Simbrief Paperwork before you start the flight.

WHAT SIMS ARE SUPPORTED BY THE VA/NEWSKY?
NewSky supports Microsoft Flight Simulator 2020/2024 and X-Plane 11/12. No additional software 
like FSUPIC or XPUIPC is required anymore!

These are our current Cost Indexes that are based loosely on real world airlines and/or 
recommended CI  from the aircraft manufacturer. This is your typical CI and can be adjusted by the 
pilot as needed for wind conditions and for making up lost time if behind schedule. Typically if you 
are behind schedule or are fighting head winds for a large portion of the flight you will want to raise 
your CI 30/50 extra points above the standard. Likewise, if you are way ahead of schedule or 
experiencing significant tailwinds you can lower the CI rating by 5/15 points on average to squeeze 
out some minor fuel savings. Remember, the higher the CI the more fuel the plane will use to 
achieve higher values in the FMC. Lower numbers conserves fuel.
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With the new Vatsim Codec being amazing there has been a return to using Vatsim. Our 
airline is in partnership with Vatsim to provide excellent immersive services for all our flying 
needs. When you sign up to join our airline if you are a member of Vatsim please supply us 
with your Vatsim PID in the appropriate info box on your application. We are required to keep 
an active list of all our pilots that use the Vatsim network by their audit department in order to 
stay in compliance with being a partnered Virtual Airline.

All pilots who use the network are to conduct themselves in a professional manner. You are a 
representative of the airline always when using any online service with our callsign. If we 
receive any complaints from the Vatsim leadership about any of our pilots we will ground that 
pilot immediately pending our own investigation. If you are found to be in violation of Vatsim 
policies, you will be terminated from the airline. No exceptions. If you are going to fly online 
as a representative of the airline always conduct yourself professionally.

While we have several divisions that have their own unique callsigns Vatsim only allows 
Virtual Airlines to use a single callsign. As such when filing a flight plan for our VA always use 
the SLR identifier for the ICAO (EX: SOA5121). All flights regardless of division will use the 
SOLARIS callsign when making voice contact with controllers

When you file your flight plan be sure you put the following information in your remarks 
section of the flight plan: SOLARIS AIR VA/SOLARISVA.ORG/ICAO SLR/CALLSIGN 
SOLARIS.  Failure to do so will probably have the controller calling you Southern Air since 
that little charter airline IRL uses the SOA ICAO identifier. This will let the controllers know 
you are part of a VA and what to call you correctly when they interact with you on voice 
comms.

If you are feeling unsure if you want to be on the Vatsim network, there are a series of 
training videos that can maybe help you get more comfortable with using the network before 
you get on it. AviationPro has a good training tutorial series to start with. You can find his 
tutorial playlist at the following URL:

https://www.youtube.com/watch?v=u10JjIP6QfY&list=PLtO_
n5SzuAadbW1hjV59Ebm6s9APfWsZM

Happy Vatsim flying pilots and we'll see you in the skies above the digital world!

JoinFS is a great alternative to flying on Vatsim/IVAO/Poscon that we use for group flying when we 
just want to relax and not deal with ATC.  JoinFS has an extremely high refresh rate the even allows 
for highspeed formation flying. You can grab a copy of JoinFS at the link below and it supports all 
major flight sims so we can all fly together regardless of sim:

https://joinfs.net/

Follow the instructions on the website for 
installation. Once it’s installed, launch 
your sim and spawn into a gate and then 
start the JoinFS client. Once the client 
loads here are some simple instructions 
on setting up your first flight on JoinFS.

The main JoinFS is small and doesn't 
take up much space. The first thing to 
note is if your Simulator box is lit green. If 
it, JoinFS is succesfully connected to the 
sim and ready for operation. The 
Network button should be red by default 
as you have not yet connected to a 
JoinFS server. If you need to disconnect 
JoinFS from the simulator for whatever 
reason just click on the green Simulator 
button. To quick connect to your previous 
server you joined just like the Network 
button. It should turn green to show you 
have connected.

Scan For Models

First thing you need to do is scan for 
models which can only be done while the 
sim is running. Click on the File drop 
menu and select Scan For Models. On 
the selection screen that opens up, turn 
off all payware and freeware planes that 
show up in the list then click the browse 
button and point JoinFS to the folder 
holding your AI models. For MSFS users 
this can be AIG or FSLTL models. In this 
example, I am pointing to the FSLTL 
models in my community folder.  Once it 
is done scanning it will tell you how many 
models it found.

Basic Settings

Next click on the File menu and select 
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Settings to bring up the settings screen. The way I have it setup in the screen shot to the right will 
typically work for everyone for basic JoinFS group flying.

Join a Server

You should be ready to join a server now. We use the Global server called Open Air Virtual Hub. To 
join the server, click on the View menu and click on Public Hubs. Find the Open Air Virtual Hub, right 
click on it and select Join. You will log into the hub and your Network button should turn green to 
show you are connected now to the server. You will show up to other players almost instantaneously.

Aircraft Menu - Subbing Out Planes and Adjusting Heights

You have full control over what model plane and livery each pilot on the network looks like. You can 
set this up quickly by using the Aircraft menu. Click the View menu option and select Aircraft. This 

will show you a list of all the other players that are near you and what model they currently are. To 
sub out a player's model right click on the their name and select the Substitute option. In the dialog 
box that opens change their plane type and pick a livery and click okay and they will change 
immediately to that new model and livery. If you find that the new model is bouncing up and down on 
the ground you right click on their name again and pick Adjust Height and change their height. We 
recommend between 50cm and 100cm height adjustment to make their plane stop bouncing. This 
information is saved for that player. Anytime that player flies with you in the future it will remember 
your settings. 

Happy Group Flying!


